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LandStar8 FAQ Series 
DESCRIPTION  

Common LandStar8 Questions, with answers 

©iGage Mapping Corporation 2024, 2025 

By: Mark Silver, mark@igage.com 
Date: May 6, 2025 

More FAQ’s like this one are available here:  [ LandStar8_FAQ ] 

Filename: LS8_FAQ_CommonLandStar8Questions.docx 

How to read this document 

This document is updated nearly every week. New questions are added to the end.  

If this is your first read through, start here at the beginning. 
If you have read this before, go to the end and read from the end back towards the beginning. Stop 
when you get to something that is familiar. 

Where are all the FAQ’s stored? 

https://igage.com/out/CHC/LandStar8/faq/index.htm 

 

I can’t get back from a menu or I can’t collapse the keyboard to see 

behind it. 

Enabling soft buttons on the bottom of the screen will help navigation through large entry forms as 
there will be a dedicated back button  and a key to collapse the keyboard while in the Survey 
modes. 

Enabling 3-button navigation depends on the brand of tablet: 

Google Pixel Devices 

 

Samsung Devices 

 

Tripltek 9 Pro 

 

Settings > Display > 
Navigation Mode 

Settings > Display Navigation 
type 

Settings > System > Gestures > 
System navigation 

mailto:mark@igage.com
https://igage.com/out/CHC/LandStar8/faq/index.htm
https://igage.com/out/CHC/LandStar8/faq/index.htm
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Select 3-button navigation Select Buttons and swipe 
gestures 
  Enable Gesture hints 
  Enable Show button to hide 
keyboard 
  > More Options > Swipe from 
bottom 

Select -3-button navigation 

Is there a curve calculator? 

How do I enter a Horizontal curve? 

The ‘Plot Deed’ function allows plotting metes and bounds deed descriptions with line and arc 
(curve) calls. There is a curve calculator that allows for the entry of right/left curves by radius, curve 
length, cord length, angle and cord bearing. You can start this function from the Tools menu, or from 
CAD view Draw > Layout. 

See this video with example file or the User Manual: 

   

23 Plotting metes and bounds deed descriptions. 

[ The example file ] 

3:43 

 

If you are looking for an angle calculator to project a point from a station, forward from a backsight 
see the next question.  

https://igage.com/LS8/LS8Training/videos/23_DeedPlotting.htm
https://igage.com/LS8/LS8Training/videos/MetesAndBoundsExample.pdf
https://igage.com/LS8/LS8Training/videos/23_DeedPlotting.htm
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Is there a triangle calculator? 

Is there a way to project a new point from an existing point using 

angle right or left at a distance? 

Yes, the Tools > Rotation COGO function does exactly this. However, you need to have the azimuth 
entry setup correctly. See this FAQ for details: 
 https://igage.com/out/CHC/LandStar8/faq/LS8_FAQ_AngleRightProjection_001.pdf  

Angle left: just enter a ‘-‘ (minus sign) before the Rotation angle.  

 

Is there a Total Station and Robotics module? 

Yes, there is a total station with/without robotics module. It is a reasonable cost and supports many, 
but not all devices. Support for Nikon, Geomax Zoom 95, Topcon, Sokkia and Leica exists. However, 
some brands require codes to enable or have recent firmware updates which restrict LandStar8 from 
working.  

Call us and we can send you a QRCode that will enable TS and RTS operation in LS8 and you can 
check compatibility with your current equipment. 

Base Positions stored in jobs 

Every GNSS point stored will generate a Base position. If they don’t show up in the point list, click the 
3-dot button and then Show GNSS Base.  

If you follow the instructions in this [ Setup Base Position ] FAQ, 

 

 a base point will always be added to the point list at the Ground Mark. If you don’t set up the base 
that is in use with LandStar8 (perhaps it is a community base that you can’t control), then the stored 
base point will reflect the L1 Phase Center (PC) or the Antena Reference Position (ARP) of the base’s 
antenna which is broadcast in the correction message.  

Even if you get the PC or ARP location, it is still possible to do Base shifts and Shift GNSS base. 

https://igage.com/out/CHC/LandStar8/faq/LS8_FAQ_AngleRightProjection_001.pdf
https://igage.com/out/CHC/LandStar8/faq/LS8_FAQ_SetupBaseKnownPosition_R002.pdf
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Shifting autonomous base positions to match an OPUS report 

Checkout the [ OPUS Solution Adjustment ] FAQ for step by step instructions. There is a built-in base 
shift adjustment routine accessible from the 3-dot button of the point list. 

 

Reversing the order of points in the point list? 

Click the 3-dot button at the top right of the point list, then click on Sort first/last to top. 

How do I move a project to another data collector? 

The easiest way is: from the main menu Project (tab), click on Projects (button), then drag the project 
you want to share/move to the right. Click on the orange share button, then choose a share method. 
Email is easiest for jobs without Visual Survey pictures. 

On the receiving data collector, download the emailed project file into the Download folder. Then in 
LandStar click on the 3-dot button in the Projects menu, browse to the file and open it. 

The transferred job will be in the available project list, you can drag it to the right to open it. 

LandStar now defaults to Gmail every time I share, how do I get the 

menu back that allows me to select a method (Gmail, Drive, Skype, 

WhatsApp, Quick Share… ) 

The required setting is actually under Gmail, not LandStar8. Go to the device settings: 

 Apps > 
 find Gmail (may be under ‘all Apps’) > 
 Open by default > 
 click on Clear default preferences (gray button at the bottom) 

Codes & Descriptions, why not just codes? 

Some other tools place the Code as the first word of the Description, except sometimes there will be 
a Code modifier (like PC) as the second word of the description, unless the modifier is special and 
then the Code may occupy 4 or more words. For example: 

 RT PC LTF LTWOH.5 OV-1.5 

Is a valid Code. This gets even more confusing with non-English languages. 

https://igage.com/out/CHC/LandStar8/faq/LS8_FAQ_OPUSAdjustment_r002.pdf
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In LandStar8, the Code and the Description are separate fields: 

  

You can enter both a Code and a Description in the Code box by inserting a question mark ‘?’ 
between the Code and Description. Everything before the ? is treated as Code and everything after 
the question mark is treated as a description: 

  

In addition to performing field to finish entry, codes can trigger the Layer that features are stored to. 
The Add matching CAD layer when a new code is entered option: 

  
will automatically add new Codes as they are defined. 

If you don’t use Codes, then you can just treat the Code as the Description. Turn off the Add 
matching CAD layer… option. You will need to import Descriptions into the Code field and export 
Codes into the Description field when exchanging text files. 

Or, if you just don’t like the question mark delimiter, click the Settings gear, then on the Survey tab 
set Confirm before saving option to enabled. A detailed code, description, invert, point details 
screen will be shown after every point is stored and you can enter the Code and Description 
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separately: 

  

Alternatively, you might put the Edit last point button (circle with 3 dots) on the tool tray, then you 
can click on the button when you want to enter a description: 

  

When importing a text file with both Code and Description into CAD tools you can let the desktop 
tool know how to interpret the fields. For example, if we use the export format: 

 Name, Northing, Easting, Elevation, Code, Description 

and export this file: 

1,3490604.740,2280582.145,5678.657,CODE1,This is Description 1 

2,3490604.783,2280582.228,5579.871,CODE2,This is 2nd Desc 

Then we can import it into Survey: 
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Which results in: 

  

CAPITALIZATION 

The options to capitalize Point names, Codes and Descriptions were added in version 20241018 so it 
is now possible to force these fields to be uppercase: 

  

If you update from a previous version of LandStar, you will need to re-download the USA localization 
package to see these options. 

Dumping the receiver’s FIX 

The new CHC receivers don’t always lose fix when inverted.  

You can add the Reset GNSS button to the tool tray in most survey methods. This deletes the 
receiver ephemeris and cycles the power on the GNSS engine. A full dump. 

If you click on the black top bar (where the SV count and instrument status is shown), then click the 
3-dot button there will be a path to reset GNSS. 

In November 2024, we added a FAST Reset which disables tracking, then reenables, however it does 
not power cycle the GNSS engine. 

I don’t like having names automatically assigned and shown on lines 

that I draw 

From the main menu, click on: 

Blue-Guy (top left corner) > 
 Software settings > 
 Display settings > 
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 drag down to Label display settings 
 disable the slider on the right side 

Line names won’t be shown anymore: 

  

I am always accidently turning off the basemap by accidently clicking 

the basemap toggle 

From the main menu, click on: 

 Blue-Guy (top left corner) > 
 Software settings > 
 Display settings > 
 drag down to Miscellaneous >   
 disable the slider Toggle Basemap Display button on map screens 

Is it possible to load a Trimble or Topcon site calibration file in 

LandStar? 

Yes:  

Project > Coordinate system > 3-DOT > Load from file  

will accept a Trimble .DC, .JXL or .CAL file (also Leica .LOK) Works or nearly works, most of the time.  

Or, if the base job is just in SPC (State Plane Coordinates), then: 

 Survey > Site calibration > 3-dot button > import  

will read those formats (above) and load the grid of point-pairs. 

Changing the underlying coordinate style for a point 

How do I use points imported from another job to add to calibration (Import > Other formats (tab) > 
Load from an existing project) Is there a way to use this imported point in a site calibration that 
requires a GNSS position? 
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Bring the point in, then edit the point in the point list by dragging the line to the right and clicking on 
the gray pencil, then use the drop down to change the point coordinate to Local Lat/Lon 
(dd.mmssssss).  

You can now use the point in a calibration that requires a GNSS position. 

How do I see my Base position in CAD? 

In the CAD view, click on the Layers button in the Tool Tray : 

  

On the Work layers tab (left tab), there will be a layer named BASE_POINTS: 

  

Click on the lightbulb to the left to turn the layer on. Click back and the base will be shown with a 
base icon next to the name: 

  

Never rotate the tablet screen! 

Screen rotation is turned off for the tablet (Settings > Display > Advanced > Auto-rotate screen is 
disabled).  

But a little rotation button shows up on the lower right corner of my screen when I am walking in the 
field and I click it by accident, the screen is stuck in Landscape mode. 

Get the ZIP file in this folder: 
https://igage.com/out/CHC/LandStar8/faq/NoRotationSuggestionFix/index.htm then decompress it 
and read the text file. 

 

https://igage.com/out/CHC/LandStar8/faq/NoRotationSuggestionFix/index.htm
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I plug in my TriplTek and it mounts as an empty drive! I want to move 

files back and forth. 

When you plug the Type-C cable from the TriplTek9 (TT9P) to a computer, it initially does not share 
the device contents as a disk drive. It connects for CHARGING only. This FAQ shows how to allow file 
access. 

Plug your TT9P into your computer. Your PC should beep, then show an empty directory folder: 

  

On the TT9P, drag down from the top left corner of the screen: 
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A system window will appear: 

  
Click on the USB message that indicates the connection is for charging only.  

It will expand to show: 

  
Click it again. 
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Change the mode to File Transfer: 

  

The PC File Explorer window will refresh, showing the contents of the TT9P: 

  

Double-clicking on the device will display the contents of the TT9P: 

  

This sequence is designed to protect you from having the entire contents of your TT9P stolen from 
you when you plug into a charger that has been compromised to allow remote access. All modern 
Android devices include this protection. 
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I can not get a cellular SIM card to work in my Tripltek 9 Pro! 

Long answer: 

[ watch the video on how to install and provision a simbase card ] 

Short answer: 

You need to set up the APN. To do this, there is a tricky step where you click on APN to add, but 
there is not a Save button. The Save function is addressed by the 3-Dot button at the top right corner 
of the menu. Nothing else in Android land works this way. 

Also, if you are using a simbase card [ see simbase ] even though the simbase interface tells you that 
the card is active, we think it takes ~20 minutes for the status to propagate through the cell 
networks. So, after enabling and setting the card up, wait 20 minutes before trying. 

How do I know if I am recording a file on my receiver? 

iBASE: click the left button until the bar moves to 3rd line. Then click the right button and it will show 
the recording time: 

  

i83: Click a button to turn on the display: 

  

The time is in little numbers at the bottom. 

The Verified survey does not automatically increment the point 

number! 

Correct, because typically you are going to rotate the pole and occupy the same point again. Most 
other methods do auto-increment by the value you choose in Settings. 

What is the warranty on iGage and CHC receivers? 

2-years, however batteries are 30-days and cables are 90-days.  

Don’t leave your receivers in your pickup truck with the windows rolled up in the summer! 

https://igage.com/tt9p/videos/TT9P_SimbaseCard.htm
https://igage.com/sim/index.html
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Can I use my iGage/CHC receiver as a base with my RTK drone? 

Yes. It works great! See: https://igage.com/out/CHC/faq/iG_CHC_FAQ_NTRIPCaster_via-
WiFi_R002.pdf 

 

Can I use my iGage / CHC receiver with SurvPC? 

If you must, read this: https://igage.com/out/CHC/faq/CHCiXXwithCarlsonSurvXX608_r002.pdf 

 

Can I open an existing Carlson SurvPC job in LandStar8? 

Yes, it will work well.  

First set the projection to match Carlson (usually a State Plane Zone). Then Project > Import > Other 
formats (tab at top) > select Carlson CRD/CRDB file > click Next and browse for the existing CRD file. 
This will import all of your points. 

If the job has a Localization (Site Calibration), click on Survey > Site calibration then click on the 3-dot 
button at the top and click on Import. Browse for the SurvXX job’s .LOC file and open it. This will load 
all of the calibration point pairs as they were defined in SurvXX. 

The LandStar8 job will now match the SurvPC job. 

Can I import my Carlson CODE list into LandStar8? 

Yes. The code list will be stored as a .FCL file on your Carlson collector. Put a copy of the .FCL file on 
your LS8 device, then Project > Codes > 3-Dot button (top right) > Load from file. 

When I store a point using Visual survey, it prepends VRTK_ to all my 

point names 

The first time you store a Visual survey point, erase the VRTK_ from the beginning of the name. 
LandStar will remember this choice and subsequent points will just be integers. 

https://igage.com/out/CHC/faq/iG_CHC_FAQ_NTRIPCaster_via-WiFi_R002.pdf
https://igage.com/out/CHC/faq/iG_CHC_FAQ_NTRIPCaster_via-WiFi_R002.pdf
https://igage.com/out/CHC/faq/CHCiXXwithCarlsonSurvXX608_r002.pdf
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When I select a point from the Point list, I can’t find the point I need 

to select 

The point may be of a type that is hidden. 

Click the Filter button on the top-left corner of the grid: 

  

Then click on All: 

  

The Filter is hiding the point you want. Even if it is set to All, sometimes you have to retrigger the All 
selection with this sequence. 

 

I am searching for a point, but I can’t find it because the point order is 

by time, and I have thousands of points. 

Try entering a search term. At the top of the list: 

  

If you click on the box where the red/yellow arrow above points (Name) you can switch between 
searching the Name, Code or Description. Select the field you want to search on, then type in part of 



© Copyright 2025 by iGage Mapping Corporation 

iGage Mapping Corporation  1545 South 1100 East STE 1  Salt Lake City UT 84015  +1 801 412-0011  f +1-801-412-0022  www.igage.com 

16 

the item you are looking for in the box to the right, the point list will only include matching entries: 

  “7”  

I can’t see the Descriptions on the map screens 

Click the Option gear, then Display (tab), then scroll down to Label display settings, enable the 
Description and optionally set the text color. 

  

Sorting the project list 

When you look at the Project list the Current Project is shown at the top of the list. The next section 
starts with a blue |Projects header: 

  

If you click on the Up/Down arrow (circled in purple above) it will change the sort order for the 
selected Time or Name. If you click on Time/Name, a drop-down box will appear, and you can sort by 
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creation date or project name. 

     
 Name increasing  Name decreasing  Time decreasing 

When I click on the store point button, it asks if I want to turn off the 

IMU! 

You are pressing the IMU control button: 

  

Press the Start Measurement button instead: 

  

How do I type an ‘M’ for meters when entering an Instrument Height? 

When entering a field that is primarily numeric, a numeric keyboard like this will be shown: 
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If you need a ‘M’ for meters, or another letter, click on this button: 

  
and the keyboard will expand to alphanumeric: 

  

If you don’t have the  key, then install the Google Keyboard GBoard from the play store: see 
the next section. 

Install the Google Keyboard GBoard 

The Google keyboard GBoard is highly recommended for use with LandStar. GBoard can be 
downloaded and installed from the Google PlayStore if the device has GMS (Google Mobile Services). 

 Play Store > search for Gboard > Install Gboard – the Google keyboard 

Once installed follow the instructions to select and enable Gboard as the default keyboard. 

When the keyboard is shown, you can change the Gboard preferences by clicking the Settings gear: 

  

Click on Preferences then: 

 Enable Number row 

 Enable Long press for symbols 

LandStar is sluggish or hangs for a few seconds 

After installing LandStar, make the following operating system changes to prevent LandStar from 
freezing or losing permissions when running in the background, or after a few weeks of non-use. 
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Click and hold on the program icon on the desktop, then click the  App info button: 

  

Under Permissions, disable Pause app activity if unused: 

  
This will prevent the operating system from automatically removing permissions and cached files if 
LandStar is not used regularly. The removal of some permissions may result in LandStar being unable 
to start. 

Under Mobile data & Wi-Fi enable background usage of mobile Background data and Unrestricted 
data usage: 

  

Under App battery usage change battery usage to Unrestricted. This allows LandStar to continue to 
communicate with receivers and devices when another application is opened or while using the 
phone: 

  

How do I install a demo copy of LandStar8 on my phone? 

Please follow all of the instructions, in order presented in this FAQ: 
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https://igage.com/out/LandStarDistribution/LS8_Installation_Instructions/LandStar8.01_Instalation_
r605.pdf  

 

Best way to share photos collected with a Visual Survey to a PC for 

viewing? 

Just use the project share function (drag project to the right, then click on the orange share button). 
The file is probably too big to email, but it can be placed onto a thumbdrive or via the cloud using 
Google Drive/Onedrive/Dropbox. 

Here is a link to an example file: 
https://igage.com/out/CHC/LandStar8/faq/sampleVisualSuveyJob/logan01.zip 

 

The shared file will have a .ZIP extension and can be opened in Windows Explorer. Drill down to the 
Project Folder (logan01 in the example file), then ImageTask, then the task number Task1, then 
images, all of the saved images from the task will be in the folder: 

  

https://igage.com/out/LandStarDistribution/LS8_Installation_Instructions/LandStar8.01_Instalation_r605.pdf
https://igage.com/out/LandStarDistribution/LS8_Installation_Instructions/LandStar8.01_Instalation_r605.pdf
https://igage.com/out/CHC/LandStar8/faq/sampleVisualSuveyJob/logan01.zip
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You can then click on the individual photos: 

  

If the modeling option is enabled on the receiver, then the photos will have Lat/Lon/H in the Exif 
properties. 

I am staking a point, I am within 0.4’ of this point, but my display says 

that my slope distance is 3017 feet away! 

You are staking a design point with a zero elevation and your true elevation is 3017 feet. You can 
modify the design elevation by clicking the delta in the bubble at the top of the staking screen: 
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I am using a visual receiver (i89/i93) in ‘Visual survey’ mode. When I 

connect it says: ‘Loading image…’ and never shows a picture. 

  

Exit LandStar8.  

Go to Wi-Fi settings, click on the receiver Wi-Fi entry, if there is a gear matching GNSS-sn of the head, 
click on the gear and then Forget the device.  

Start LandStar8 again and click on Instrument Profile then pick the receiver profile again. The data 
collector will ask to make a temporary connection to the receiver: 

  

Click on CONNECT.  

It usually works and continues to work for a long time. This may have something to do with a system 
security setting? 
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I want to use a point for calibration, shift or some other operation that 

requires a GNSS value (Lat/Lon/EHeight), but the point I have is 

projected (North, East, Height) only. 

Open the point list, drag the point in question to the right and click on the gray edit pencil: 

   

Change the Coordinate format to WGS84 Lat/Lon (dd.mmssssss) then click Save.  

My version of LandStar8 does not have an ‘Instruments profile’ 

button! 

By default, the Instruments profile button is ‘hidden’ under the + More button. Go to the Config tab, 
click the + More button, click on the bouncing blue + button at the top right corner of the Instrument 
profile button and it will move to the main Config page. Click Back to exit the More menu. 

The operating system repeatedly asks for location permission for LS8, 

however it is already granted. 

LandStar8 may have the required permission, however Location services may be GLOBALLY 
DISABLED: 
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 Tripltek 9 Pro    Google Pixelx 

There is a little play button on my screen. How do I make it go away? 

 < If you see this on the lower right corner of the screen, then… 

Click on the Blue guy (top left corner) > then on the left panel look for “Show video help for float(ing) 
button”: 

 

Turn slider off. 

How do I use Dropbox with LandStar? 

Open the Play Store search for Dropbox and add the Dropbox app to the tablet.  

Open Dropbox app and sign-in or make a new account. 

Now, when you Export and enable the Share slider, Dropbox will be available as a target destination. 

Dropbox is not integrated into LandStar8 as a cloud provider (for importing files directly from the 
cloud.) Instead open the Dropbox app and find the files you want, download them to the Download 
folder and then import directly from the Download folder. 

How do I connect LandStar8 to the internal GNSS receiver on my data 

collector? 

Config > Connect to instruments 



© Copyright 2025 by iGage Mapping Corporation 

iGage Mapping Corporation  1545 South 1100 East STE 1  Salt Lake City UT 84015  +1 801 412-0011  f +1-801-412-0022  www.igage.com 

25 

If the data collector is currently connected to something, click the Disconnect button at the bottom. 

Configure as shown here: 

  
Click the Connect button. 

You may want to also save the current settings (all of the tolerances and settings like GNSS > Survey 
> Store fixed solutions only) to a named set: BlueGuy (top left corner) > Software settings > Save 
then Save to file and enter an appropriate filename name like RTK. 

After you change all the tolerances and settings for use with the internal GPS, save these settings 
(perhaps as IntGPS) so you can quickly switch back and forth. 
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When I try to store a point, I get a confusing message about Corner 

Point and I can’t continue. 

You have inadvertently clicked this Map Survey type screen icon: 

    

And changed it to the Corner type survey: 

  

Click it again and switch back to Topographic or Quick topographic mode. 

Staking a line between points, without drawing a permanent line 

In version 20241205 a new feature has been added to allow building a temporary line between 
points, then staking the temporary line directly (with stationing, random or node stationing. 

To begin, click the 

  
Line/Arc stakeout button from the main menu Survey tab.  



© Copyright 2025 by iGage Mapping Corporation 

iGage Mapping Corporation  1545 South 1100 East STE 1  Salt Lake City UT 84015  +1 801 412-0011  f +1-801-412-0022  www.igage.com 

27 

The Line stakeout menu will be shown: 

  

Click in the white box (see above), then click or pick a series of points to build a temporary polyline: 

  

You can also pick points using the  Point list, Clicking the  button will display the length and 

bearing of the defined line segment or polyline details. The  Undo button removes the last drawn 
segment. 
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Click Next to complete definition of the polyline, then choose between Station & Offset, Random line 
or line Node staking: 

  

Finally click Stakeout to continue normal line staking. 

Circle Tangents 

Version 20250123 introduces the ability to pick the tangent point on a circle for drawing a line. 

Tangent point is defined in the Snap to object menu, which can be shown by click-and-holding the 

Snap button on the Tool tray: 
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With Tangent point enabled, you can target the tangent point of a circle when drawing a line: 

  

Dedicated Tangent point drawing functions have been added to the main menu Tools tab: 

  

And the Draw menu within the CAD view: 
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These tools automate circle tangen point selection: 

  

How do I add a random point, from the background image? 

From the Survey > CAD viewer, click and hold on the Snap tool: 
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The Snap menu will be shown: 

  

Turn the Any slide on, then click YES. 

  

Click on Draw (1) then Point (2). 
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Now tap on the Snap button (1): 

  

Then drag the Snap tool (2) to the location where you want to set a point. When you release your 
finger from the cyan dot (1), an orange point will be left on the map: 

  

Click OK (2). 
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The Add point dialog will be shown: 

  

After entering the Code and Description click OK. A new point at the clicked location will be in your 
Point list. 

Data collector will not connect to receiver by Bluetooth 

This issue happened on a Samsung S24+ phone. It may be a single occurrence issue, however if it 
happens again, this description might save you several hours. 

When Bluetooth was selected, the GNSS-xxxxxxx instrument was never discoverable from within LS8. 
The instrument could be discovered and paired in the OS Bluetooth Manager, but even when paired 
it never showed up in LandStar8 as an instrument that could be connected to. 

To fix the issue, we clicked and held on the LandStar8 APP icon on the desktop, clicked on the little 
(i), then went to Storage and cleared the cache, then cleared the data. Upon restarting LandStar8 
again, we had to reauthorize all the permissions and download the Localization package again. 
Instrument profiles and the LandStar serial number were not lost. 

What is FEC when setting up radio protocols? 

FEC is Forward Error Correction. See https://en.wikipedia.org/wiki/Error_correction_code for a 
detailed description of exactly how it works. 

This setting is available in these radio protocol modes: 

 Satel, Transparent EOT 

This setting is forced ON in the TrimTalk 450 protocol.  

Turning on FEC adds about 30% additional overhead to the message. With very high satellite 
availability, this will increase the message length above the carry capacity of the radio channel. 

For example, with RTCM3.2 MSM4, with 38 SV’s tracked, a typical single average message may be 
740 bytes. Turning on FEC makes the message length 970 bytes (740 payload+ 222 EC overhead). At 

https://en.wikipedia.org/wiki/Error_correction_code
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9600 baud, there is time in one second for 960 bytes. Thus the transmission channel is completely 
saturated and is unable to empty out the transmission buffer every second.  

Because a new message is sent every second, there may be no benefit to including error correction 
as the Rover typically will only need a single message every 5 seconds for optimal operation. 
However, in a continuously noisy environment, FEC ON may have a significant advantage over FEC 
OFF. 

The Satel format allows double the data to be transmitted in the same bandwidth: 

 TRANSPARENT EOT 12.5 KHz 4800 baud 480 CPS 

 SATEL   12.5 KHz 9600 baud 960 CPS 

Because a message must be sent twice per second for repeater operation, the SATEL 19200 baud 
mode is typically the only protocol that can be time-store repeated. However, the 19,200 baud 
protocol is 25 Khz bandwidth and most FCC licenses are limited to 12.5 KHz.  

In this environment, the extra 30% overhead is a very bad thing, thus we recommend FEC OFF or 
DISABLED. 

 


